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Experiment (1) 

 

Plotting a GM Plateau 

 
 

 

OBJECTIVES: 
 

  To determine the plateau and optimal operating voltage of a Geiger-Muller counter. 

   

 

EQUIPMENT REQUIRED: 
 

 Radioactive Source (e.g., Cs-137, Sr-90, or Co-60). 

 

 Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply,   

GM Tube, shelf stand, serial cable, and a source holder For the stand). 

 

 

 

Figure 1: experiment setup 

 

DISCUSSION AND THEORY: 

Radiation was discovered in the late 1800s. Wilhelm Roentgen observed undeveloped 

photographic plates became exposed while he worked with high voltage arcs in gas tubes, 

similar to a fluorescent light. Unable to identify the energy, he called them “X” rays. The 

following year, 1896, Henri Becquerel observed that while working with uranium salts and 
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photographic plates, the uranium seemed to emit a penetrating radiation similar to Roentgen’s 

X-rays. Madam Curie called this phenomenon “radioactivity”. 

 Further investigations by her and others showed that this property of emitting radiation is 

specific to a given element or isotope of an element. It was also found that atoms producing 

these radiations are unstable and emit radiations at characteristic rates to form new atoms. 

Atoms are the smallest unit of matter that retains the properties of an element (such as 

hydrogen, carbon, or lead).  

The central core of the atom, called the nucleus, is made up of protons (positive charge) and 

neutrons (no charge). The third part of the atom is the electron (negative charge) which orbits 

the nucleus. 

 In general, each atom has an equal amount of protons and electrons so that the atom is 

electrically neutral. The atom is made of mostly empty space. The atom’s size is on the order 

of an angstrom (1 Å), which is equivalent to 1x10
-10

 m while the nucleus has a diameter of a 

few fermis, or femto-meters, which is equivalent to 1x10
-15

 m. This means that the nucleus 

only occupies approximately 1/10000 of the atom’s size. Yet, the nucleus controls the atom’s 

behavior with respect to radiation. (The electrons control the chemical behavior of the atom.) 

 

Origins of Radiation 

 

Radioactive materials that we find as naturally occurring were created by: 

 

1. Formation of the universe, producing some very long lived radioactive elements, such as 

Uranium and Thorium. 

 

2. The decay of some of these long lived materials into other radioactive materials like 

Radium and Radon. 

 

3. Fission products and their progeny (decay products), such as Xenon, Krypton, and Iodine. 

Man-made radioactive materials are most commonly made as fission products or from the 

decays of previously radioactive materials. Another method to manufacture radioactive 

materials is activation of non-radioactive materials when they are bombarded with neutrons, 

protons, other high energy particles, or high energy electromagnetic waves. 

 

The Geiger-Müller Counter 
 

Geiger-Müller (GM) counters were invented by H. Geiger and E.W. Müller in 1928, and are 

used to detect radioactive particles (α and β) and rays (γ and X).  

A GM tube usually consists of an airtight metal cylinder closed at both ends and filled with a 

gas that is easily ionized (usually neon, argon, and halogen). One end consists of a “window” 

which is a thin material, mica, allowing the entrance of alpha particles. (These particles can 

be shielded easily.) A wire, which runs lengthwise down the center of the tube, is positively 

charged with a relatively high voltage and acts as an anode. The tube acts as the cathode. The 

anode and cathode are connected to an electric circuit that maintains the high voltage between 

them. 

When the radiation enters the GM tube, it will ionize some of the atoms of the gas (counting 

gas). 

 Due to the large electric field created between the anode and cathode, the resulting positive 

ions and negative electrons accelerate toward the cathode and anode, respectively. Electrons 

move or drift through the gas at a speed of about 104 m/s, which is about 104 times faster 

than the positive ions move.  
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The electrons are collected a few microseconds after they are created, while the positive ions 

would take a few milliseconds to travel to the cathode.  

As the electrons travel toward the anode they ionize other atoms, which produces a cascade 

of electrons called gas multiplication or a (Townsend) avalanche. The multiplication factor is 

typically 106 to 108.  

The resulting discharge current causes the voltage between the anode and cathode to drop. 

The counter (electric circuit) detects this voltage drop and recognizes it as a signal of a 

particle’s presence.  

There are additional discharges triggered by UV photons liberated in the ionization process 

that start avalanches away from the original ionization site. 

These discharges are called Geiger-Müller discharges. These do not affect the performance as 

they are short-lived.  

 

Now, once you start an avalanche of electrons how do you stop or quench it?  

The positive ions may still have enough energy to start a new cascade. One (early) method 

was external quenching which was done electronically by quickly ramping down the voltage 

in the GM tube after a particle was detected. This means any more electrons or positive ions 

created will not be accelerated towards the anode or cathode, respectively. 

 

 The electrons and ions would recombine and no more signals would be produced. The 

modern method is called internal quenching. A small concentration of a polyatomic gas 

(organic or halogen) is added to the gas in the GM tube. The quenching gas is selected to 

have a lower ionization potential (~10 eV) than the fill gas (26.4 eV).  

 

When the positive ions collide with the quenching gas’s molecules, they are slowed or 

absorbed by giving its energy to the quenching molecule. They break down the gas molecules 

in the process (dissociation) instead of ionizing the molecule. Any quenching molecule that 

may be accelerated to the cathode dissociates upon impact producing no signal. If organic 

molecules are used, GM tubes must be replaced since they break down over time (about one 

billion counts). However, the GM tubes included in Spectrum Techniques® set-ups use a 

halogen molecule, which naturally recombines after breaking apart. 

 

 

All Geiger-Müller (GM) counters do not operate in the exact same way because of 

differences in their construction. Consequently, each GM counter has a different high voltage 

that must be applied to obtain optimal performance from the instrument. If a radioactive 

sample is positioned beneath a tube and the voltage of the GM tube is ramped up (slowly 

increased by small intervals) from zero, the tube does not start counting right away.  

The tube must reach the starting voltage where the electron “avalanche” can begin to produce 

a signal.  

As the voltage is increased beyond that point, the counting rate increases quickly before it 

stabilizes. Where the stabilization begins is a region commonly referred to as the knee, or 

threshold value. 

 Past the knee, increases in the voltage only produce small increases in the count rate. This 

region is the plateau we are seeking.  

Determining the optimal operating voltage starts with identifying the plateau first. The end of 

the plateau is found when increasing the voltage produces a second large rise in count rate. 

This last region is called the discharge region. 

 To help preserve the life of the tube, the operating voltage should be selected near the middle 

but towards the lower half of the plateau (closer to the knee). 
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 If the GM tube operates too closely to the discharge region, and there is a change in the 

performance of the tube; then you could possibly operate the tube in a “continuous discharge” 

mode, which can damage the tube. 
 

 
Figure 2: typical GM plateau 

 
By the end of this experiment, you will make a graph similar to the one in Figure 2, which 

shows a typical plateau shape. 

 

 

Procedure: 

 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  

2. Remove the red endcap from the GM tube VERY CAREFULLY. Place the GM tube 

into the top of the shelf stand with the window down and BNC connector up. 

3. Attach the BNC cable to the GM tube and ST-350. 

4. Attach the serial cable to the ST-350 and a serial port on the back of your PC (if you 

are using one).  

5.  Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  

6. Open the computer interface by pressing the START key on the PC. Then look under 

Programs -> SpecTech options for the ST350 option. You should then see the blue 

control panel appear on your screen. 

 

 

7.  Go to the Setup menu and select the HV Setting option. In the High Voltage (HV) 

window, start with 700 Volts. In the step voltage window, enter 20. Under Step 

Voltage Enable, select On (the default selection is off). Finally, select OK. 

 

8.  Go under the Preset option and select Preset Time. Enter 30 for the number of 

seconds and choose OK. Then also under the Preset option choose Runs. In the 

window, enter 26 for the number of runs to make. 

 

9.  You should see a screen with a large window for the number of counts and data for 

all the runs on the left half of the screen. On the right half, you should see a window 

for the preset time, elapsed time, runs remaining, and HV and step voltages. If not, go 

to the view option and select counts. 
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10.  Make sure no other previous data by choosing the erase button (last one on the right). 

Then select the green diamond to start taking data. 

 

11.  When all the runs are taken, choose the File menu and Save As. Then you may save 

the data file anywhere on the hard drive or onto a floppy disk. The output file is a text 

file that is tab delimited, which means that it will load into most spreadsheet 

programs. See the Data Analysis section for instructions in doing the data analysis in 

Microsoft Excel ®. Another option is that you may record the data into your own data 

sheet and graph the data on the included graph paper. 

 

12.  You can repeat the data collection again with different values for step voltage and 

duration of time for counting. However, the GM tubes you are using are not allowed 

to have more than 1200 V applied to them. Consider this when choosing new values. 

 

 

Data Analysis 

 

1. Open Microsoft Excel ®. From the File Menu (choose Open). Find the directory where 

you saved your data file (The default location is on the C drive in the SpecTech directory).  

You will have to change the file types to All Files (*.*) to find your data file which ends with 

(.tsv), and then select your file to open it. 

 

2. The Text Import Wizard will appear to step you through opening this file. You may use 

any of the options available, but you need only to press Next, Next, and Finish opening the 

file with all the data. 

 

 

3. To see all the words and eliminate the ### symbols, you should expand the width of the A 

and E columns. Take the cursor up to where the letters for the columns are located. When the 

cursor is on the line between two columns, it turns into a line with arrows pointing both ways. 

Directly over the lines between the A and B columns and E and F columns, double-click and 

the columns should automatically open to the maximum width needed. 

 

4. To make a graph of this data, you may plot it with Excel ® or on a sheet of graph paper. If 

you choose Excel, the graphing steps are provided. 

 

5. Go the Insert Menu and choose chart for the Chart Wizard, or select it from the top 

toolbar (it looks like a bar graph with different color bars). 

 

6. Under Chart Types, select XY (Scatter) and choose Next. (This default selection for a 

scatter plot is what we want to use.) 

 

7. For the Data range, you want the settings to be on “=[your file name]!$B$13:$C$32”, 

putting the name you chose for the data file in where [your file name] is located (do not 

insert the square brackets or quotation marks). Also, you want to change the Series In 

option from Rows to Columns. To check to see if everything has worked, you should have a 

preview graph with only one set of points on it. Or you can go to the Series Tab and for X 

Values should be “=[your file name]!$B$13:$B$32” and for Y Values should be “=[your file 

name]!$C$13:$C$32”. If this is correct, then choose Next again. 
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8. Next, you are given windows to insert a graph title and labels for the x and y-axes. Recall 

that we are plotting Counts on the y-axis and Voltage on the x-axis. When you have 

completed that, choose the legend tab and unmark the show legend option (remove the check 

mark by clicking on the box). A legend is not needed here unless you plotting more than one 

set of runs together. 

 

9. Next, you are asked to choose whether to keep the graph as a separate worksheet or to 

shrink it and insert it onto your current worksheet. This choice is up to your instructor or it 

depends on how you want to choose your data presentation for any lab report. 

 

Questions: 

 

1. The best operating voltage for the tube = … (volts). 

 

2. Will this value be the same for all the different tubes in the lab? 

 

3. Will this value be the same for this tube ten years from now? 

 

4. One way to check if the experimental operating voltage is on the plateau is to find the 

slope of the plateau with your voltage included. If the slope for a GM plateau is less than 

10% per 100 volt, then you have a “good” plateau. Determine where your plateau begins and 

ends, and confirm it is a good plateau.  

The equation for slope is: 

(C1-C2)/(V1-V2) 

 

 Where C1 and C2 are the counts of start and end points, respectively. V1 and V2 are the 

voltages of start and end points, respectively. (This equation measures the % change of the 

activities and divides it by 100 V.) 
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Data Table for Geiger Plateau Lab 
 

 

 

Voltage counts Voltage  counts 
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Experiment (2) 

Statistics of Counting 
 

 

 

Objectives:: 

 

In this experiment, the student will investigate the statistics related to measurements with a 

Geiger counter. Specifically, the Poisson and Gaussian distributions will be compared. 

 

Introduction: 

 

Statistics is an important feature especially when exploring nuclear and particle physics. In 

those fields, we are dealing with very large numbers of atoms simultaneously. We cannot 

possibly deal with each one individually, so we turn to statistics for help. Its techniques help 

us obtain predictions on behavior based on what most of the particles do and how many 

follow this pattern.  

These two categories fit a general description of mean (average) and standard deviation. 

A measurement counts the number of successes resulting from a given number of trials. Each 

trial is assumed to be a binary process in that there are two possible outcomes: trial is a 

success or trial is not a success. For our work, the probability of a decay or non-decay is a 

constant in every moment of time. Every atom in the source has the same probability of 

decay, which is very small.  

The Poisson and Gaussian statistical distributions will be investigated and studied in this 

experiment.  

 

Equipment 

 

   Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply/ 

transformer, GM Tube, shelf stand, serial cable, and a source holder for the stand) – 

Shown in Figure 1. 

 Radioactive Source (Cs-137 is recommended – the blue source in Figure 1) 
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Figure 1: Setup for ST350 with sources and absorber kit 

 

 

Procedure: 

 

1. Setup the equipment as you did in the Experiment #1, and open the computer interface. 

You should then see the blue control panel appear on your screen. 

2. Go to the Preset menu to preset the time to 5 and runs to 150. 

3. Take a background radiation measurement. (This run lasts twelve and half minutes to 

match the later measurements.) 

4. When you are done, save your data onto disk (preferred for 150 data points). 

5. Repeat with a Cesium-137 source, but reset the time to 1 and the number of runs to 

750 (again will be twelve and a half minutes.) 

 

 

Data Analysis: 

 

1. Open Microsoft Excel ®. Import or enter all of your collected data. 

2. First, enter all of the titles for numbers you will calculate. In cell G10, enter Mean. 

In cell G13, enter Minimum. In cell G16, enter Maximum. In cell G19, enter Standard 

Deviation. In cell G22, enter Square Root of Mean. In cell H10, enter N. In cell I10, enter 

Frequency. In cell J10, enter Poisson Dist. Finally, in cell K10, enter Gaussian Dist. 

3. In cell G11, enter =AVERAGE(C12:C161) – this calculates the average, or mean. 

4. In cell G14, enter =MIN(C12:C161) – this finds the smallest value of the data. 

5. In cell G17, enter =MAX(C12:C161) – this finds the largest value of the data. 

6. In cell G20, enter =STDEV(C12:C161) – this finds the standard deviation of the data. 

7. In cell G22, enter =SQRT(G11) – this takes a square root of the value of the designated 

cell, here G11. 

8. Starting in cell H11, list the minimum number of counts recorded (same as Minimum), 

which could be zero. Increase the count by one all the way up until you reach the maximum 

number of counts. 
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9. In column I, highlight the empty cells that correspond to N values from column H. Then 

from the Insert menu, choose function.  

A window will appear, you will want to choose the FREQUENCY option that can be found 

under Statistical (functions listed in alphabetical order). Once you choose Frequency, another 

window will appear. 

In the window for Data_Array, enter C12:C161 (cells for the data).  

In the window for Bin_Array, enter the cells for the N values in column H. (You can 

highlight them by choosing the box at the end of the window.) STOP HERE!! If you hit OK 

here, the function will not work.  

You must simultaneously choose, the Control key, the Shift key, and OK button (on the 

screen). Then the frequency for all of your N values will be computed. If you did not do it 

correctly, only the first frequency value will be displayed.  

10. In cell J11, enter the formula: 

=$G$11^H11/FACT(H11)*EXP(-$G$11)*150,  for the Poisson Distribution. (You must 

multiply the standard formula by 150, because the standard formula is normalized to 11.) 

11. In cell K11, enter the formula: 

(1/($G$20*SQRT(2*PI())))*EXP(-(H11$G$11)^2)/(2*$G$20^2))*150, for the Gaussian 

Distribution. Note that in Excel the constant pi is represented by (PI). Again, you must 

multiply by 150 to let the function know how many entries there are. 

 

12. Next, make a graph of all three distributions: Raw Frequency, Poisson distribution and 

Gaussian distribution. Start with the Chart Wizard either by choosing Chart 8from the Insert 

Menu or pressing its icon on the top toolbar. (See Lab #1 if you need more detailed 

instructions.) 

 

13. For your graph, select the N values in the H column and the Frequency values in the I 

column. Now add two more series, one for the Poisson distribution and one for the Gaussian 

distribution. 

 

14. Print the graph to hand in to your instructor. 

 

15. Repeat this whole data analysis procedure for your counts with Cs-137. 

 

Questions: 

 

1. List the formulas for finding the means and standard deviations for the Poisson and 

Gaussian distribution. 

 

2. A student in a previous class of the author’s once made the comment, “Why do we have to 

learn about errors? You should just buy good and accurate equipment.” How would you 

answer this student? 

 
3. Which distribution matches the data with the background counts? How well does the 

Gaussian distribution describe the Cs-137 data? 

 

4. Why can’t you get a value for the Poisson distribution with the data from the Cs-137 

source? 

 

5. How close are the standard deviation values when calculated with the Poisson and 

Gaussian distributions? Is one right (or more correct)? Is one easier to calculate? 
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Experiment (3) 
 

Resolving Time 
 

 

 

OBJECTIVES: 
 

1- To illustrate methods by which the resolving time of a Geiger-Muller counter may be 

determined. 

2- To determine the resolving time of a Geiger-Muller counter. 

 

     

 

EQUIPMENT REQUIRED: 
 

 Radioactive Source (e.g., Cs-137, Sr-90, or Co-60). 

 Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply,   

GM Tube, shelf stand, serial cable, and a source holder For the stand). 

 

 

DISCUSSION AND THEORY: 

When a particle decays and produces radiation, those particles or rays can produce an ion pair 

through ionization in the Geiger tube. The electrons travel to the anode more quickly than the 

positive ions travel to the cathode. During the time it takes the positive ions to reach the 

cathode, the tube is insensitive to any radiation.  

During this time, if a second ionizing ray strikes the tube it will not be detected because the 

tube cannot tell there is another electron avalanche present. 

 The Geiger counter only sees one “big” electron avalanche, until it has been reset after 

detection.  

Basically, the counter cannot produce pulses for more than one particle, because the counter 

is “occupied” with the particle that arrives earliest. This phenomenon is sometimes called 

coincidence. 
 

Dead time: is the time interval after a pulse had occurred during which the counter is 

insensitive by which two pulses must be separated to be detected as separate pulses. 

Recovery time: is the time interval that must elapse after a pulse has occurred before a full-

size pulse can again occur.  

The phenomenon of a second or even third ionizing ray striking the tube during the resolving 

time is known as coincidence and the correction applied is known as the coincidence 

correction. 

As a result of coincidence, the observed count is always less than the true count.  

An approximate correction for resolving time (based on an assumed resolving time of about 

300ms) can be made by adding 0.555% per 1000 cpm to the observed counting rate. Thus, if 

the observed count is 3000 cpm the correction to be added would be 3 x 0.555% or 1.665% of 

3000. In this case the approximate true count would be 3050 cpm. 

 

If the tube were perfect, it would measure N counts in the time interval t; however, the tube is 

inoperative for part of this time: td, and does not detect some of the radiation.  
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If the true count rate is R then the tube misses a certain number of counts 

N(missed) = R*td 

Therefore the number of counts measured is: 

N(measured) = N - N(missed) 

Or: 

N(measured) = N - R*td 

And the count rate "r" measured is just N / t or 

r(measured) = R - (R*td) / t 

This reduces to: 

r(measured) = R ( 1 - td/t)  

From this expression the true count rate "R" can be determined 

(1 )d

r
R

t

t





        (1) 

 

 

The counting time "t" is known, but the tube dead time "td" is not known. 

 We do know that the time that the tube becomes inoperative will be proportional to the 

number of counts i.e. the tube becomes even more "flooded "for higher count rates. Therefore 

an assumption will be made that the dead time can be represented by: 

 

td = constant * N 

 

Where the "constant" has units of time and which can be substituted into the above rate 

equation to give: 

 

(1 tan * )

r
R

N
cons t

t





          (2) 

 

This reduces to the correction equation: 

 

(1 )

r
R

RT



     (3) 

If constant = T; then "T" is called the resolving time, R is true count rate (= N/t) and r is 

observed count rate (= n/t).  

 

When r is plotted as a function of R, it is seen that r and R are nearly equal at very low count 

rates; but as R is increased further, the observed count rate begins to lag because of the 

increase in the coincidence loss. 

 Ultimately, when very active samples are measured, the observed count rate is seen to 

decrease, finally decreasing to zero. 

 Although one may not often encounter such active samples, it is very important to be 

cognizant of this behavior since one might be led to believe a sample is safe to handle 

whereas in reality it is dangerously radioactive.  

These properties of the correction function are illustrated in figure (1). The straight line at 45 

degrees represents the relationship for no correction between the true count rate "R" and the 

measured count rate "r". The lower curve is a plot of the true count rate correction equation 

(1) above. As explained it goes to zero at very high count rates. The middle curve is a plot of 

the second correction function, equation (2) above.  
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Equation (3) will be used for the resolving time correction to the experimentally measured 

data. 

 

 
 

Figure.1: measured count rate vs. true count rate 

 

 

The resolving time can be measured by the method of paired sources. The activities of two 

sources are measured individually (r1 and r2) and then together (r12).  

A convenient form for the sources consists of placing a small quantity of radioactive material 

only on one side of the small plastic disk and a second small quantity of radioactive material 

is placed on the other half of this same disk, then the disk is cut into two pieces.  

The quantities should be approximately not exactly equal and should give a count rate of at 

least 10,000 cpm. 

 One might expect that the measured rates; r1 + r2 = r12; but because of resolving time, this is 

not so.  

It is true, however, that: 

 

R1+R2=R12+Rb         (4) 

 

Where Rb is the background count and must be added to R12 since two background counts are 

included in the sum of R1 and R2, whereas R12 includes only one background. It follows then: 

 

1 2 12

1 2 121 1 1 1

b

b

rr r r

rT rT r T r T
  

   
              (5) 

Where: r1, r2, r12 and rb = activities of samples 1, 2, the combined samples and the 

background respectively. 

 

Although all quantities except T can be measured, the form of this relationship is awkward 

for the calculation of T, and several approximate relationships have been proposed. 

 For example, if background is considered negligible the fourth term may be omitted. In our 

laboratory experiment this will be true. The samples will be measured inside a lead shield and 

the background count rate will be on the order of 30 cpm. Multiplying by the least common 

denominator and expanding, the following relationship is easily derived: 

 

         (6) 
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After the value of resolving time has been determined, observed sample activities can be 

corrected for coincidence loss by means of equation 3. 

 

 

Procedure: 

 

1.  Carefully determine the activity of the sources individually and combined, being sure to 

retain identical geometry and backscattering effects. 

 

2. Measure the values of r1, r2, r12 and rb. Note the sequence in which the measurements are 

made. This sequence is used to permit the smallest number of changes possible, thereby 

allowing the possibility of a more reproductive geometry. 

 

3. Place source one (S-1) in position with the blank next to it. Count for at least five minutes. 

Note: the error in the counts is equal to the square root of the number of counts not the count 

rate. Keep this error as small as possible. 

 Calculate the activity in counts per minute. This is r1. 

 

4. Carefully remove the blank and replace it with source two (S-2). 

Count for the proper time. Calculate the activity in counts per minute. This is r12. 

 

5. Carefully remove source one (S-1) and replace it with the blank. Count for proper time. 

Calculate the activity in counts per minute. This is r2. 

 

6. Carefully remove source two (S-2) and replace it with blank two (B-2). Count for proper 

time. Calculate the activity in counts per minute. This is rb. 

 

7. This resolving time correction will be used in all calculations, therefore, it is very 

important that its value be known as precisely as possible.  

The repeatability of the value can be determined by making several identical measurements 

as described above. Repeat steps 1 through 6 at least 3 or 4 times. The uncertainty in the 

measured resolving time can be determined from these measurements. 

 

8. Change the distance between the counting tube and the source. Repeat the measurements 

as described above. 

 

9. Change the distance between the counting tube and the source again. Repeat the  

measurements as described above. 
 

Calculation 

 

 

1. Subtract the measured background count rate from each of the measured sample count 

rates. 

The background count rate is so low that it is not necessary to correct for resolving time. 

 

2. Calculate the resolving time by means of equation (6) for the three sets of measurements 

and tabulate below. 

 

3. Correct each of the observed activities (r1, r2, r12) for coincidence to obtain (R1, R2,  

 R12) respectively. Add r1 and r2 and compare with r12. Similarly add R1 and R2 and 

compare the sum with the value of R12. 
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r1 _____________________      R1 _____________________ 

r2 ____________________        R2 _____________________ 

r1 + r2 ____________________ R1 + R2 _________________ 

r12 ___________________        R12 _____________________ 

 

4. Consider the two correction equations presented above equations (2) and (3). 

(1 )

r
R

RT



 ,  

(1 )

r
R

rT



 

where R is the true rate and "r" is the measured rate.  

The first equation gives the most correct decay rate, but because of the mathematical form it 

is difficult to use.  

The second equation also gives the true rate but it is not as precise as the first equation, 

however, it will be used in all of our calculations since the mathematical form is much easier 

to use. 

 

5. Use the experimentally determined resolving time "T" and one of your measured count 

rates, and determine the true rate by using each of these expressions. It may be necessary to 

use Mathematica's Solve function to determine "R" from the first expression. Compare your 

two corrected rates. Will there be a problem in using the less precise expression for your 

measurements? 

 

 

 Questions: 
 

1. When radiation travels through the window of the GM tube, what happens so that the tube 

sends a signal that it has detected a particle? 

 

 

2. Can the GM counter distinguish between one or more particles when they are present in 

the tube at the same time? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 17 

Experiment (4) 

Geiger Tube Efficiency  

 
 

OBJECTIVES: 
 

To determine the efficiency of a Geiger-Muller counter for various types of radiation. 
  
 

EQUIPMENT: 
 

 Radioactive Source (e.g., Cs-137, Sr-90, or Co-60). 

 Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply,   

GM Tube, shelf stand, serial cable, and a source holder For the stand). 

 

 

THEORY AND DISCUSSION: 

 
From earlier experiments, you should have learned that a GM tube does not count all the 

particles, which are emitted from a source, i.e., dead time. In addition, some of the particles 

do not strike the tube at all, because they are emitted uniformly in all directions from the 

source. In this experiment, you will calculate the efficiency of a GM tube counting system for 

different isotopes by comparing the measured count rate to the disintegration rate (activity) of 

the source. 

 

To find the disintegration rate, change from micro-Curies (μCi) to disintegrations per minute 

(dpm). The disintegrations per minute unit are equivalent to the counts per minute from the 

GM tube, because each disintegration represents a particle emitted. 

 

The conversion factor is: 

 

1 Ci = 2.22*10
12

dbm    (1) 
 
Multiply this by the activity of the source and you have the expected counts per minute of the 

source. We will use this procedure to find the efficiency of the GM tube, by using a fairly 

simple formula.  

You want to find the percent of the counts you observe versus the counts you expect, so you 

can express this as 

 

Efficiency(%) =r(100)/CK 

 

 In this formula, r is the measured activity in cpm, C is the expected activity of the source in 

mCi, and K is the conversion factor from Equation 1. 

 
 

Procedure: 
 

1. Setup the Geiger counter as in the previous experiments. Set the Voltage of the GM tube to 

its optimal operating voltage, which should be around 820 Volts. 
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2. From the Preset menu, set Runs to zero and set Preset Time to 60 to measure activity in 

cpm. 

 

3. First do a run without a radioactive source to determine your background level. 

 

4. Next, place one of the radioactive sources in the top shelf and began taking data. 

 

5. Repeat this for each of your other two sources. Remember that the first run is a background 

number. 

 

6. (OPTIONAL) From the Preset menu, change the Preset Time to 300, and take data for 

all three sources again. 

 

7. Save your data to disk, and fill the data sheet before exiting the ST350 program. 

 

 
Questions: 
 
1. Is the efficiency you calculated for each isotope valid only for that isotope? 

Explain your answer. 

 

2. If a different shelf is used, will the efficiency change? Explain your answer. 

 

3. The radius of the GM tube’s window is 3.5 cm. The source is 3 cm from the GM tube. 

Compare the surface area of a sphere 3 cm from the source to the area of the GM tube’s 

window. (Hint: find the ratio) How is this related to this experiment? Can this tell you if your 

results are reasonable? 

 

4. (Correlates if five minute and one minute runs were taken.) Are the efficiencies different? 

How different? Why? 
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Experiment (5) 

Inverse Square Law 

 

 

Objective: 

To investigate inverse square law by using a gamma source. 

 

EQUIPMENT: 
 

 Radioactive Source (e.g., Cs-137, Sr-90, or Co-60). 

 Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply,   

GM Tube, shelf stand, serial cable, and a source holder For the stand). 

 

 

Discussion and Theory 

 

There are many similarities between ordinary light rays and gamma rays. They are both 

considered to be electromagnetic radiations; hence they obey the classical equation 

E = h.v 

Where: E = energy of the photon in ergs (10
-7

J),  

v = the frequency of the radiation (s
-1

), and,   

h = Planck’s constant (6.624 x 10
-27

 ergs.s). 

 

Therefore, in explaining the inverse square law it is convenient to make the analogy between 

a light source and a gamma-ray source. 

Let us assume that we have a light source that emits light photons at a rate, N0 

photons/second.  

It is reasonable to assume that these photons are given off in an isotopic manner, that is, 

equally in all directions. 

 If we place the light source in the center of a clear plastic spherical shell, it is quite easy to 

measure the number of light photons per second for each cm
2
 of the spherical shell. This is 

the intensity which is given by 

 

             (1) 

                                                                  (2) 
 
 

Where N0 = the total number of photons/second from the source, R0= radius of the sphere 

(cm) and A0 = the surface area of the spherical shell (cm
2
). 

 From equations (1) and (2) you could notice that:  

 
 

Procedure 
 

1. Set the GM tube at the proper operating voltage, and place the Co-60 source 1 cm away 

from the face of the window. 

 

2. Count for a period of time long enough to get reasonable statistics (~4000 counts). 
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3. Move the source to 2 cm and repeat the measurement for the same amount of time. 

Continue for the distances listed in the table. (Note that for the longer distances the time will 

have to be increased to obtain the same statistics). 
 

 

Distance (cm) Activity Corrected Activity 

1   

2   

3   

4   

5   

6   

7   

8   

9   

 

 

4. Correct the activity for dead time and background and fill in the corrected activity in the 

table. 

 5. On linear graph paper, plot the corrected activity (x axis) as a function of distance. Since 

the intensity is proportional to the activity, this plot should have the 1/R
2
 characteristics 

exhibited by equation (1). 

 From the corrected activities in the table: 

 

2

K
A

R


 
Where: 

R = the distance for each measurement (cm), 

A = the correct activity, and 

K = a constant which is to be determined from the individual entries in the table. 

 

5. Calculate K for each entry, the average value and standard deviation of K .value from K? 

 

 

 Questions: 
 

1. How can you determine the activity of a radioactive source? Find the activity of the three 

sources you used in this experiment. 

 

2. Do you expect efficiency to be good or bad for each of your sources? (Consider real-world 

effects) 
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Experiment (6) 
 

Backscattering 

 

 
Objective: 

1- The student will investigate the relationship between types of absorber material 

(atomic number) and backscattering. 

2- The student will investigate the relationship between absorber thickness and 

backscattering. 

 
 
Pre-lab Questions: 
1. Calculate what percentage of the entire “sphere” surrounding the source does the 

GM window occupy. 

2. Backscattering does have dependencies on atomic number and on thickness. Does either 

one dominant the amount of backscattering versus the other? What kind of dependence do 

you predict for each (direct, inverse, inverse square for example – be descriptive)? 

 
Discussion and Theory 

 

Radiation is emitted from a source in all directions. The radiation emitted within the angle 

subtended by the window of the GM tube is the only radiation counted.  

Most radiation is emitted away from the tube but it strikes matter. When it does so, the 

direction of its path may be deflected. This deflection is known as scattering. Most particles 

undergo multiple scattering passing through matter. Beta particles especially may be scattered 

through large angles. 

 Radiation scattered through approximately 180
0
 is said to be backscattered. For Geiger 

counters, the fraction of radiation emitted away from the GM tube that strikes the material 

supporting the sample. It is deflected toward the tube window and is counted. 

A beta particle entering matter undergoes a series of collisions mostly with the atom and 

sometimes orbital electrons. 

 A collision between particles does not occur in the same manner we picture them in the 

macroscopic world. There is very little contact collisions, but instead the term, collision, 

refers to any interaction, coulombic or otherwise. (A coulombic interaction is an electrical 

attraction or repulsion that changes the path of the particle’s motion.)  

A collision may be elastic or inelastic, but in either case the result is not only a change in 

direction but usually a decrease in the energy of the beta particle as well (inelastic). 

 

In the first part of the experiment, we will investigate the effect of the size of the nucleus on 

backscattering since this would seem most likely effect the number of backscattered beta 

particles.  

This can be determined by using absorbers as backing materials. Even though the metal 

pieces you will use are called absorbers, in this experiment, they will also be used to deflect 

radiation upward into the GM tube. To eliminate any other effects, the absorbers will be the 

same thickness but different atomic number (and thus different sized nuclei).  

In the second part of the experiment, you will use absorbers of the same material (atomic 

number) and different thickness. 

This is a common experimental technique, fixing one variable and varying another to 

investigate each one individually 
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Normally when we think of thickness, we think of linear thickness that can be measured in a 

linear unit such as inches or centimeters. However, in nuclear and particle physics, thickness 

refers to area thickness.  

This is the thickness of the absorbers in mg/cm2. The absorptive power of a material is 

dependent on its density and thickness, so the product of these two quantities is given as the 

total absorber thickness, or area thickness. We determine area thickness with the equation: 

Density (mg/cm3) X thickness (cm) = Absorber thickness (mg/cm2)       (1) 

 

You will determine the dependence that absorber thickness has on backscattering. 

 
 
EQUIPMENT: 
 

 Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply – 

transformer, GM Tube, shelf stand, serial cable, and a source holder for the stand) 

 Radioactive Source (THIN* beta emitter) 

 Part I: Backscatter Absorber Kit – Plastic (poly-carbonate), Aluminum, copper, Tin, 

Lead, and “an unknown” Discs. 

 Part II: (Regular) Absorber Kit – the Aluminum and Lead pieces will be used. 

 

 

Procedure: 

 
Part I – Atomic Number Dependence 

1. Setup the Geiger counter as you have in the previous experiments. Set the Voltage of the 

GM tube to its optimal operating voltage, which should be around 900 Volts. 

 A thin source is required to reduce self-absorption by the source. This enables beta particles 

sent downward that are scattered back up toward the GM tube may pass through the source 

again. 

 

2. From the Preset menu, set Runs to zero and set Preset Time to 60. 

 

3. First do a run without a radioactive source to determine your background level. 

 

4. Next, place the radioactive source in the second shelf from the top and take data. 

 

5. Place an absorber piece, or disk, in the source holder and place the source directly on top 

of it. 

 

6. Repeat this for all of the various absorbers (different materials) including the unknown. 

 

7. Record the data to a file on disk or into a data table. 

 

Part II – Thickness Dependence 

 
1. Setup the Geiger counter as you have in the previous experiments. Set the Voltage of the 

GM tube to its optimal operating voltage, which should be around 900 Volts. 

 

2. From the Preset menu, set Runs to zero and set Preset Time to 60. 
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3. First do a run without a radioactive source to determine your background level. (Do not 

repeat if this part is being performed in the same lab period as Part I.) 

 

4. Next, place the radioactive source in the second shelf from the top and begin taking data. 

 

5. Place the source directly on top of one of the absorbers. Take data by clicking on the green 

diamond. 

 

6. Place the source on a different absorber and insert into the second shelf. Click on the green 

diamond to begin taking data. 

 

7. Repeat for at least three other absorber thicknesses. 

 

8. Record the data to a file on disk or into a data table. 

 
Data Analysis: 

 
Part I – Atomic Number Dependence 

 

1. Open Microsoft Excel ® and import your data into it. 

 

2. In cell E2, enter Dead Time = and in cell F2 enter the dead time determined for your GM 

tube. 

 

3. In cell G9 enter Dead Corr. and in cell G10 enter Counts. In cell G13, enter a formula to 

correct for dead time. Copy this down for the cells that have counts in column C. 

 

4. In cell H9 enter Corrected and in cell H10 enter Counts. In cell H13, enter a formula to 

correct for background counts. Copy this down for the cells that have counts in column G. Is 

background significant? Can you back up your answer numerically? 

 

5. In cell I9 enter Atomic and in cell I10 enter Number. In cell I13 and below, enter the 

atomic numbers for the absorbers you used to get obtain the corresponding counts. 

(Plastic is poly-carbonate** – Z = 6, Aluminum – Z = 13, Copper – Z = 29, Tin – Z = 

50, and Lead – Z = 82) 

 

6. To double-check the general result of our data that we will graph below, we will calculate 

the percentage of counts that were due to backscattering and compare that to the Z values. To 

calculate the percent of counts from backscattering, use the following formula  

 

 
 

 Where r is the corrected count rate (cpm) and ro is the count rate without any absorber 

present.  

To do this in Excel, in cell J9 enter Percent and cell J10 Backscatt. In cell J13, enter the 

formula =((H13-$H$13)/$H$13)*100. This should give 0 for cell J13 but not for the rest. 

 

7. Next, make a graph of Corrected Counts vs. Atomic Number. Start with the Chart 

Wizard either by choosing Chart from the Insert Menu or pressing its icon on the top toolbar. 
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9. Select the Atomic Number values in the I column and Corrected Counts values in the H 

column. 

 

10. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items. 

 

11. Choose whether you want to view your graph as a separate worksheet as your data, or you 

wish to see a smaller version of the graph with the data. 

 

12. Adjust the size of the graph for your preference (or the instructor’s). You may also wish 

to adjust the scales on one or more of the axes. Again, this is a preference issue. 

 

13. Right click on one of the data points and from the menu that appears, choose Add 

Trendline. Make sure that the Linear option is chosen (should be darkened). Then click on 

the Options tab and check the boxes for Display equation on chart and 

Display R-squared value on chart. This will make the equation of the best fit line appear as 

well as a number that represents the percent of linearity of the data. 

 
 
Part II – Thickness Dependence 

 
1. Open Microsoft Excel ® and import 

 

2. In cell E2, enter Dead Time = and in cell F2 enter the dead time determined for your GM 

tube. 

 

3. In cell G9 enter Dead Corr. and in cell G10 enter Counts. In cell G13, enter a formula to 

correct for dead time. Copy this down for the cells that have counts in column C. 

 

4. In cell H9 enter Corrected and in cell H10 enter Counts. In cell H13, enter a formula to 

correct for background counts. Copy this down for the cells that have counts in column G. 

 

5. In cell I9 enter Thickness and in cell I10 enter (in). In cell I13 and below, enter the 

thickness of the absorbers (0.32, 0.063, or 0.125 inches) for the aluminum and lead 

 

6. Calculate the percentage of counts that were due to backscattering. In cell J9 enter 

Percent and cell J10 Backscatt. In cell J13, enter the same formula as for Part I for percent of 

backscattering. This should give 0 for cell J13 but not for the rest. 

 

5. Next, make a graph of Corrected Counts vs. Thickness. Start with the Chart Wizard either 

by choosing Chart from the Insert Menu or pressing its icon on the top toolbar. 

 

6. Select the Thickness values in the I column and Corrected Counts values in the H column. 

 

7. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items. 

 

8. Choose whether you want to view your graph as a separate worksheet as your data, or you 

wish to see a smaller version of the graph with the data. 

 

9. Adjust the size of the graph for your preference (or the instructor’s). You may also wish to 

adjust the scales on one or more of the axes. Again, this is a preference issue. 
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10. Right click on one of the data points and from the menu that appears choose Add 

Trendline. Make sure that the Linear option is chosen (should be darkened). Then click on 

the Options tab and check the boxes for Display equation on chart and 

Display R-squared value on chart. This will make the equation of the best fit line appear as 

well as a number that represents the percent of linearity of the data. 

 

 
Conclusions: 
What is your conclusion about the dependence of backscattering on atomic number? How 

about on thickness? 

 
 
Post-Lab Questions: 

 

1. Justify your answers to the questions about the dependences of backscattering. 

 

2. Do your backscattering calculations confirm your results? 

 

3. What element (or material) is the unknown absorber? 

 

4. What would be the predicted count rate for a uranium disk of the same size as those used in 

Part I? How about if it was ¼ in. thick (qualitative answer, higher or lower)? Show your work 

and explain any reasoning 
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Experiment (7) 
 

 

Absorption of Gamma Rays 

 

 

Objective: 

 
The student will investigate the attenuation of radiation via the absorption of gamma rays. 

 

 
Pre-lab Questions: 

 

1. How do gamma rays interact with matter (hint: there are three)? 

2. Where are gamma rays on the electromagnetic spectrum? What are the characteristics 

(high, low, short, or long) of their wavelength, frequency, and energy? 

3. How do you calculate mass thickness (g/cm2) from other quantities of a material? 

 
Discussion and Theory 

 

Gamma radiation unlike alpha and beta radiation consists of electromagnetic waves. Gamma 

rays are emitted as photons, or little “packages” of energy called quanta, which travel at the 

speed of light (c = 3.0 x 10
8
 m/s).  

What differentiates gamma rays, x-rays, visible light, and radio waves are their position in the 

electromagnetic spectrum. What actually happens is that some of these “zones” actually 

overlap, especially between x-rays and gamma rays.  

 

One significant difference between x-rays and gamma rays is their origin. X-rays are 

produced in the electron shells, while gamma rays are produced in the nucleus. 

 X-rays are created when electrons undergo a deceleration or jump to lower energy levels. 

Gamma rays are created by energy transitions in the nucleus. 

 In this experiment, we are mostly concerned with gamma rays, because any x-rays present 

will be shielded by air and matter acting as absorbers. 

When a beam of gamma rays impinges on a sheet of absorbing material, some of the 

radiation will be absorbed or scattered. 

 As the thickness of the absorber is increased, the fraction of the radiation passing through 

will decrease. When exactly half the radiation passes through the absorber (and the other half 

is absorbed or scattered); the thickness of the absorber is called the half thickness, X1/2. 

 

This thickness, X1/2, is not normally how we perceive thickness. We normally consider it to 

be a distance possibly in cm.  

Here, thickness is short for mass thickness. Why? Because the thickness of different materials 

represents different amounts of matter (atoms). But a mass thickness is used to represent how 

much matter is being passed through (regardless of whether it is air, aluminum, or lead). 

 To calculate mass thickness you simply multiply the density of the material (g/cm3) times its 

length, or normal thickness, (cm) to get the mass thickness (g/cm2).  

The absorbers you will use for this experiment have their thickness listed as mass thickness 

because that quantity can be used to compare the plastic to lead absorbers. 

Since the intensity of radiation is reduced by 50% by passing through one X1/2, it will be 

reduced by another 50%, or only to 25% of the original intensity, in passing through a second 

X1/2 of absorber.  
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A linear relationship is obtained if the data are plotted using semi-log paper or if the 

logarithm of the activity is plotted as a function of the absorber thickness. 

The attenuation (or absorption and scattering) of gamma rays is exponential in nature which 

is shown by the equation: 

        (1) 

 

Where I is the intensity of the beam after passing through X amount of aborbing material, Io 

is the original intensity, μ is the mass attenuation coefficient, and X is the mass thickness. 

Since the intensity of the gamma rays is cut in half after passing through X1/2, we can rewrite 

Equation 1 as 

   (2) 

 

 

The Io terms cancel giving 

 
Which can again be rewritten by taking the natural logarithm of both sides 

 
Using the rules of exponents, we know that ln(1/2) = -ln(2), so that gives 

 

  
 

One final rearrangement gives us a value of the mass attenuation coefficient 

 
 

Equipment  



   Set-up for ST-350 Counter with GM Tube and stand (Counter box, power supply – 

transformer, GM Tube, shelf stand, serial cable, and a source holder for the stand) 
 

Procedure: 

 

 

1. Setup the Geiger counter as you have in the previous experiments. Set the Voltage of the 

GM tube to its optimal operating voltage, which should be around 900 Volts. 

2. From the Preset menu, set Runs to zero and set Preset Time to 60. 

3. First do a run without a radioactive source to determine your background level. 

4. Next, place the radioactive source in the second shelf from the top and begin taking data. 

5. Place an absorber piece in the top shelf and take another run of data. 

6. Repeat thisa minimum of 5 more times with absorbers of increasing thickness. 
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Data Analysis: 

 

1. Open Microsoft Excel ® and import your data into it. 

 

2. In cell E2, enter Dead Time = and in cell F2 enter the dead time determined for your GM 

tube. 

 

3. In cell G9, enter Thickness and in cell G10 enter mg/cm2. Then starting in cell 

G13, enter the thickness for the absorbers used. For cell G13, it should be zero (no absorber 

used). In column F, under Notes, it may be convenient to enter the letters associated with the 

absorbers you used. 

 

4. In cell H9 enter Dead Corr. and in cell H10 enter Counts. Then starting in cell H13, enter a 

formula to correct for the dead time of the GM counter. Copy this formula down the column 

for all the data you collected. 

 

5. In cell I9 enter Corrected and in cell I10 enter Counts. Then starting in cell I13, enter a 

formula to correct for the background of the GM counter. Copy this formula down for all the 

data you have. 

 

6. Next, make a graph of Corrected Counts per Minute vs. Thickness. Start with the 

Chart Wizard either by choosing Chart from the Insert Menu or pressing its icon on the top 

toolbar. 

 

7. Select the Thickness values in the G column and the Corrected Counts values in the I 

column. 

 

8. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items. 

 

9. Choose whether you want to view your graph as a separate worksheet as your data, or you 

wish to see a smaller version of the graph with the data. 

 

10. Right click on the y-axis of the graph and choose the Format Axis option. Then choose 

the Scale Tab, and check the Logarithmic Scale option towards the bottom. 

11. Add a Trendline to your data to obtain the equation of the best fit line through your data. 

 

Conclusions: 

From your best fit line equation, find the values for X1/2 and μ, make sure your answers are in 

the appropriate units (involving grams and centimeters). 

 

Post-Lab Questions: 

1. is your data linear? If not, why? 

2. Looking at your data and equating intensity and counts per minute, does your result for 

X1/2 a correct approximation? (Does your result match the data?) 

3. Can we be completely shielded from gamma rays? If not, then why bother? 

4. Comparing your range for alpha particles, the absorption of beta particles, and now the 

results for gamma rays, why are they different? 
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